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Preface 
Audience 
This book is written for hardware installer/service personnel, system 
integrators, and field engineers. 

Safety Warnings 
Servicing 
Caution: This product does not contain user serviceable parts. 
Servicing should only be performed by a qualified service technician. 

Fuse Replacement 
Caution: For continued protection against risk of fire, replace only 
with the same type and ratings of fuse. 

Attention:  Pour prévenir et vous protéger contre un risque de feu, 
remplacer la fusible avec une autre fusible de même type, seulement. 

Power Supply Cord Used as Disconnect Means 
Caution: The power supply cord is used as the main disconnect 
device. Ensure that the socket outlet is located/installed near the 
equipment and is easily accessible. 

Attention:  Le cordon d'alimentation est utilisé comme interrupteur 
général. La prise de courant doit être située ou installée å proximité du 
matériel et être facile d'accés. 
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Lithium Battery Warning 
Caution: Danger of explosion if battery is incorrectly replaced. 
Replace only with the same or equivalent type as recommended by the 
manufacturer. The battery is battery is recyclable. At the end of its 
useful life, under various state and local laws it may be illegal to 
dispose of this battery into the municipal waste. Contact officials for 
recycling options or proper disposal. 

Attention:  Il y a danger d'explosion s'il y a remplacement incorrect de 
la batterie. Remplacer uniquement avec une batterie du même type ou 
d'un type recommandé par le constructeur. Mettre au rébut les 
batteries usagées conformément aux instructions du fabricant. 

Battery Disposal (Switzerland) 
Refer to Annex 4.10 of SR814.013 for battery disposal. 

IT Power System 
This product is suitable for connection to an IT power system with a 
phase-to-phase voltage not exceeding 240 V. 

Peripheral Usage 
This terminal should only be used with peripheral devices that are 
certified by the appropriate safety agency for the country of installation 
(UL, CSA, TUV, VDE) or those which are recommended by NCR 
Corporation. 
 

Caution: DO NOT connect or disconnect a printer, keyboard, or any 
other terminal-powered peripheral while the terminal is powered on. 
Doing so may result in peripheral or system damage. 

Environmental Consciousness 
NCR is demonstrating its concern for the environment by designing an 
intelligent power management system into this terminal that operates 
efficiently whether the system is in a stand-alone or network 
environment. 
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Grounding Instructions 
In the event of a malfunction or breakdown, grounding provides a 
path of least resistance for electric current to reduce the risk of electric 
shock. This product is equipped with an electric cord having an 
equipment-grounding conductor and a grounding plug. The plug must 
be plugged into a matching outlet that is properly installed and 
grounded in accordance with all local codes and ordinances. Do not 
modify the plug provided – if it will not fit the outlet, have the proper 
outlet installed by a qualified electrician. Improper connection of the 
equipment-grounding conductor can result in a risk of electric shock.  

The conductor with insulation having an outer surface that is green 
with or without yellow stripes is the equipment-grounding conductor.  

If repair or replacement of the electric cord or plug is necessary, do not 
connect the equipment-grounding conductor to a live terminal. Check 
with a qualified electrician or service personnel if the grounding 
instructions are not completely understood, or if you are in doubt as to 
whether the product is properly grounded.  

Use only 3-wire extension cords that have 3-prong grounding plugs 
and 3-pole receptacles that accept the product’s plug. Repair or replace 
damaged or worn cords immediately. 
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Radio Frequency Interference Statements 

Federal Communications Commission (FCC) 
Information to User 
This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in 
a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference in which case the user 
will be required to correct the interference at his own expense. 

NCR is not responsible for any radio or television interference caused by unauthorized 
modification of this equipment or the substitution or attachment of connecting cables 
and equipment other than those specified by NCR. The correction of interference 
caused by such unauthorized modification, substitution or attachment will be the 
responsibility of the user. The user is cautioned that changes or modifications not 
expressly approved by NCR may void the user’s authority to operate the equipment. 

Canadian Department of Communications 
This digital apparatus does not exceed the Class A limits for radio noise emissions 
from digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications. 

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les 
limites applicables aux appareils numériques de la classe A prescrites dans le 
règlement sur le brouillage radioélectriques édicté par le ministrère des 
Communications du Canada. 

Voluntary Control Council for Interference (VCCI) 
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Introduction 
The NCR RealPOS 62 (also referred to as NCR 7460) is an interactive 
touch screen terminal designed specifically for the hospitality 
marketplace. Housed in an integrated, compact cabinet, the 7460 
supports a complete set of peripherals. 

The major hardware features of the 7460 are a flat panel display with 
touch screen input, LAN connectivity, and magnetic stripe reader. 

The 7460 is Internet/Intranet ready. System loading can occur from a 
network server, and software and data content may be delivered from 
a server through standard internet protocols. 
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Serial Number Labels 

7460

20145

NCR Corp. Model:7460-01        S/N 35012156
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Hardware Modules 
Base Unit 

• Processor Board 
− Celeron-class processor 

− SVGA chipset 

− MPEGII chipset 

− 4 Mbps Flash BIOS (not CMOS) 

− Four RS-232 ports (three powered) 

− Parallel port 

− 10/100BaseT Ethernet LAN chipset, Wake-on-LAN support, 
and RJ-45 port 

− Two USB type A ports 

− PS/2 keyboard/mouse port 

− External VGA display port. (This does not allow different 
information on each display. If you use an external display, you 
get the same screen that you do on the operator display.) 

− Serial touch screen interface (dedicated COM3) 

− Two DIMM RAM socket 

− IDE support for a hard disk 

− Cash drawer port 

• 12.1-Inch LCD Operator Display 

• Resistive touch screen 

• 3.5-Inch hard disk 

• Integrated Power Supply 

• 3-meter Ethernet cable 

• U.S. power cord 
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Hardware Options 
• Integrated 3-track ISO MSR 

− Side Mount (side of display) 

− Front Mount (front panel under the display) 

• Customer displays 

− Integrated 2x20  

− Remote 2x20 

• Cash drawers 

− 2189 Cash Drawer (modular) 

− 2113 Cash Drawer (modular) 

− 7454-K005 Mid-range Cash Drawer (modular) 

• Printers: 

− 7167, 7197, 7196, TMU-200, TMU-230, 2214 

• 256 MB Compact Flash (through IDE interface) 

• PS/2 Workstation keyboard 

• Telequip Coin Dispenser 

• 7892 Hand-held Scanner 

• 5945 Electronic Payment Terminal 

• 5992 Signature Capture Device 

• 5974 4x20 Remote Customer Display 

• 5973 International Remote Customer Display 
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Terminal Components not Supported 
It is important to note that the terminal does not support the following 
components. 

Not supported Alternative implementation 

CMOS for hard totals, logs, 
and tallies 

Hard disk, or server storage 

Removable media, e.g., a flex 
disk 

LAN communication to an NT server 
via standard protocols 

SLP terminal loading Local storage and TCP/IP 
networking; PXE terminal loading 

Keylock for security (X, L, R, S) Reset switch based security 

ISA and PCI Expansion slots USB and LAN based devices (future) 

DVD ROM  

Internal UPS External UPS 

Manual Video and audio 
controls 

Server 

Windows 3.1, Windows NT 
3.51, OS/2 

Win2000, NT 4.0, Win98, DOS 
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System Configuration Diagram 
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Hardware Module Descriptions 
Processor Board 

Processor/Chip Set 
The terminal uses an Intel architecture processor, which permits it to 
leverage existing software drivers and applications, as well as provide 
the greatest flexibility in choosing an operating system. This provides 
several other advantages: 

• Capable of MPEG-1 or MPEG-2 playback at 30 frames per second 
with 22 kHz stereo audio (may be limited by OS constraints). 

• Java Benchmark performance > 1000 Caffeinemarks, JIT compiled 

• OS support to run Java 

• Expansion capabilities for optional features and future 
requirements (ISA/PCI bus and USB) 

Video Subsystem 
The video subsystem supports the following LCD types: 

• 12.1-Inch active matrix (TFT) 800 x 600 with 64 k colors 

Support for the LCD integrated display is provided internally. External 
support for SVGA monitors (800 x 600 [or better] resolution and 64 k 
[or better] colors) is provided by a CRT 15-Pin D-shell connector. 

In addition to OFF and ON modes, a dimmed mode is supported in the 
hardware to allow increased tube life. If appropriate software drivers 
are loaded, full brightness is restored when touched, or an application 
requests it (e.g., to play promotional material on a preset schedule). 
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Ethernet 10/100Base-T LAN Communications 
Each processor board contains a unique IEEE MAC address. This 
address is combined with other configuration parameters into a 
configuration data file, which is then used to program the LAN 
EEPROM. Intel’s EEUPDATE.EXE utility can be used to program the 
EEPROM with the desired data file.  

The terminal may be connected to either a 10 Mbps or 100 Mbps 
Ethernet connection. The hardware automatically selects the correct 
speed (if enabled by software to do so).  

The LAN hardware supports wakeup packet capability as defined in 
the Device Class Power Management Specification, Network Device 
Class (available from Microsoft’s web site). 

When the platform is in the Soft OFF state (refer to the Power 
Management section), receipt of a Wakeup Packet on the LAN can 
return the system to the ON state, if this feature is enabled by software. 

100Base-T is wired identically to 10Base-T, except that the twisted pair 
cable must be Category 5 and the hubs must permit 100 or 10/100 
Mbps operation. Although 10Base-T will operate on Category 3 twisted 
pair, or NCR 747 cable, an upgrade to Category 5 is required for 
100Base-T. 

A customer desiring to use the terminal in an existing 10Base-T 
environment can do so and run at 10 Mbps. In order to upgrade to 
100Mbps, Category 5 cable and 100 or 10/100 hubs must be installed. 
NCR strongly recommends the use of Category 5 for all new cabling, 
even if the customer initially intends to run only 10Base-T. 

LED Indicators for Link Integrity (verifies cable and hub connection are 
good) and LAN speed is provided on the processor board next to the 
LAN connector. The LED is ON (yellow) when the speed is 100 Mbps. 

Link Integrity is provided to the PC chipset to permit boot-up software 
to verify the presence of the LAN connection. Software must allow 2 
seconds after power-up in order for the Link Integrity signal to become 
valid. 
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Universal Serial Bus 
Two USB Type-A ports are provided on the terminal. Power to the 
connectors is fused using self-healing fuses. USB devices requiring 
more than 750mA @ 5V need an external power supply. 

Note: USB peripherals require support from the operating system. 

Serial Ports 
In Setup, you can Disable, Enable, or Auto Configure each serial port. 
Under the Enabled option, the serial ports can be assigned to I/O 
addresses 3F8H, 2F8H, 3E8H or 2E8H and IRQs 3 or 4. Under the Auto 
option, the BIOS or Operating System chooses the I/O & IRQ 
configuration. This flexibility permits you to logically swap the 
operating system’s COM ports. 

Example: Serial port 1 can be configured to be COM2 and serial port 
2 can be configured to be COM1.  

Serial ports 2, 3, and 4 can be configured to provide +12V (0.5A each, 
up to 1.0 A total)* on pin 9 of the RS-232 connector (normally Ring 
Indicator (RI)). 

There is an option in the BIOS for each of the three powered serial 
ports that determines how the BIOS controls the power pin. If the BIOS 
serial port power option is set OFF, the port has no power applied on 
pin 9; if it is set ON, the port always has power applied on pin 9, 
regardless of the presence of the modified NCR peripheral cable. If the 
serial port power option is set to Auto, power is applied on pin 9 if the 
modified cable is detected. If the cable is not detected, power is not 
applied to pin 9. The BIOS default for the three powered serial ports is 
Auto. 

* If power requirements exceed 90 Watts for a total system configuration, then 
the current on the powered serial ports will be reduced or limited.  Maximum 
powered serial peripheral configurations can be specified to limit the total 
power required through COM2 to COM4 in order to accommodate a 90-Watt 
power supply. 
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If an NCR device requiring power is attached to the port, it has the 
modified cable, which ties DCD, DTR, and DSR together. If the BIOS 
has been set to Auto, then DTR is automatically toggled at power up.  
If DCD and DSR both toggle with DTR, the BIOS provides power to the 
serial port. 

The power to the serial ports is fused with self-healing type fuses. 

Parallel Port 
The processor board provides a standard 25-pin D-shell parallel port 
(LPT1) and an internal 16-pin (2 x 8) header to a second parallel port 
(LPT2). The 16-pin header has fused power and the standard parallel 
signals to drive the integrated customer display. 

The parallel ports can be configured in Setup as output only, bi-
directional mode, ECP, or EPP modes. Also, you can Disable, Enable or 
Auto configure the parallel port. Under the Enabled option, the parallel 
port can be assigned to I/O addresses 278H, 378H, or 3BCH and IRQs 
5 or 7. Under the Auto option, the BIOS or Operating System chooses 
the I/O & IRQ configuration. The BIOS default for the parallel port is 
Auto. 

PS/2 Keyboard and Mouse Interface 
The processor board provides one standard PS/2 connector (6-pin mini 
din), which supports a PS/2 keyboard or PS/2 mouse. The 5V power 
to this connector is fuse protected. 

Note: A Y-cable is required to operate a PS/2 mouse and keyboard 
simultaneously 

Hardware Monitor 
The hardware monitor generates an interrupt to the system whenever 
any of the internal voltages used by the system processor goes above or 
below the acceptable operating range. An interrupt is also generated 
when the temperature of the processor exceeds safe levels. Software 
can use this indication to slow or stop the system and/or force a reset. 
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Mini PCI Expansion Header 
A single Mini PCI expansion header is provided. 

IDE Header 
A standard IDE header is provided to support the 3.5-inch hard disk 
drive. 

Processor Board Connectors 
All connectors are either keyed or impossible to plug incorrectly due to 
mechanical design of the product. 

MSR 
There are two MSR options for the 7460. 

• Side Mount MSR – mounted vertically to the side of the operator 
display 

• Front Mount MSR – mounted horizontally to the front of the 
terminal base 

The MSR (ISO and JIS formats) interface supports a maximum of 3 
tracks of magnetic stripe information. 

Side Mount MSR 
The Side Mount MSR uses the NCR Wedge interface, which controls 
input devices such as the MSR and keyboard data, and merges the data 
from each of them into the data stream of the PC keyboard. 

The MSR signals are routed through the display head and connected to 
the PS/2 keyboard connector on the terminal. 

Note: The MS-DOS Diagnostic Support Tools, starting with version 
5.00.04, has been modified with an option to re-program the Wedge 
Side Mounted MSR for either Wedge Sentinels or OPOS/TAPS 
Sentinels. 
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Front Mount MSR 
The MSR interface controller is a memory-mapped device, which can 
reside at system memory addresses DE000-DFFF or DA00-DBFF. 
Activate the MSR interface by enabling it in BIOS Setup under IO 
Configuration. If MSR capability is not desired, it may be disabled 
through BIOS Setup. 

The MSR cable connects to the MSR connector on the processor board.  

Graphics Subsystem 
The Celeron processor board is equipped with integrated AGP 
graphics using the Intel 810 Chipset. 

Resolutions Supported 

Resolution Colors Max Vfreq 

800 x 600 x 16 bpp 64 k 85 Hz 

Colors Supported 

Resolution 256 Colors 
(8-Bit) 

65,000 Colors 
(16-Bit) 

16.7 M Colors 
(24-Bit) 

800 x 600 512 k 1 Mbps 2 Mbps 

Board BIOS 
The processor board uses a Phoenix BIOS, which is stored in Flash 
ROM. The Flash BIOS also contains the Setup utility, Power-On Self 
Tests (POST), and APM 1.2. The board also supports system BIOS 
shadowing, allowing the BIOS to execute from onboard write-
protected DRAM. 

The BIOS displays a sign-on message during POST identifying the type 
of BIOS and a five-digit revision number. 
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FLASH memory Implementation 
The Intel 82801AB Firmware Hub (Flash ROM) is organized as a 
512KBx8 device (4Mb total). It is divided into eight blocks, each of 
64KB size. The physical ROM occupies FFF80000h through FFFFFFFFh 
in high memory and the run-time BIOS occupies E4000h through 
FFFFFh in lower memory. 

BIOS Upgrades 
Flash memory makes distributing BIOS upgrades easy. A new version 
of the BIOS can be installed from the hard disk, network, or through a 
serial port. 

The disk-based flash upgrade utility, PHLASH.EXE, ensures the 
upgrade BIOS extension matches the target system to prevent 
accidentally installing a BIOS for a different type of system. 

Setup Utility 
The ROM-based Setup utility allows the system configuration to be 
modified without opening the system for most basic changes. The 
Setup utility is accessible only during the Power-On Self Test (POST) 
by pressing the <F2> key after the POST memory test has begun and 
before boot begins. A prompt may be enabled that informs users to 
press the <F2> key to access Setup. 

Note: Since the Setup Utility supports touch input, an external 
alphanumeric keyboard is not required. However, it is recommended 
for ease of use. 

Plug and Play 
The Processor BIOS also has a setup option to support the Windows 
runtime plug and play utilities. When this option is selected, only 
devices critical to boot are assigned resources by the BIOS. Device 
Node information is available for all devices to ensure compatibility 
with plug and play operating systems. System configuration 
information is stored in ESCD format. The ESCD data will be cleared 
upon loss of the battery voltage. 
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Operator Display 

20084  
The 7460 is available with a 12.1-Inch TFT (active matrix) 12.1-Inch 
LCD. 

LCD Adapter Board 
The signals from the LCD header on the processor board are brought to 
the LCD on a harness. Since there are multiple pin configurations and 
connector types being used on the LCD, a small adapter board is used 
to receive the LCD harness and map the signals into the correct pin-out 
for the LCD panel. This board has a connector that plugs directly into 
the LCD panel. 

LCD Backlight Inverter Module 
The backlight for the 7460 is contained on the LCD Adapter Board. 
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Operator Touch Screen 
The touch screen completely covers the LCD and is mounted directly 
in front of the LCD, and is held in place by the front plastic bezel of the 
terminal. The touch controller on the processor board supports 
resistive touch glass. 

The touch glass has an integrated harness that is routed into the LCD 
board enclosure and is connected to a header on the LCD board. The 
touch glass has a glare-reducing texture that also helps hide 
fingerprints. 

NCR 7460 Integrated Customer Display  
The NCR 7460 Integrated Customer Display supports two lines of 
twenty 5x7 characters. 

18892

Integrated Customer Display

 
The 7460 also supports the following remote customer displays. 

• NCR 5954 4x20 Remote Customer Display 

• NCR 5973 2x20 International Customer Display 
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Hardware Features 
Magnetic Stripe Reader 

A single 3-track analog Magnetic Stripe Reader (MSR) is available as a 
feature, supporting ISO format cards. There are two versions available: 

• Side Mounted MSR 

• Front Mounted MSR 

When the MSR is not desired filler pieces are included as substitutes. 

20116

Side Mounted MSR

Front Mounted MSR
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Printer Options 

NCR 7167 Printer 
The NCR 7167 Printer is a fast, quiet, relatively small, and very reliable 
multi-function printer. It prints receipts, validates and prints checks, 
and prints on a variety of single or multiple part forms. There is no 
journal. The printer features a dual interface, so it can connect to the 
host terminal either through a USB or RS-232 interface. It receives its 
power from an external power supply. It also has a connector for cash 
drawers. 

19711c

Power Supply

AC Adapter Cable
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NCR 7197 Printer 
The NCR 7197 Printer is a fast, quiet, relatively small and very reliable 
multi-function printer. It prints receipts and two-color printing. The 
printer features a dual interface, so it can connect to the host terminal 
either through a USB interface or RS-232. It receives its power from an 
external power supply. It also has a connector for cash drawers. 

19712b

Power Supply

AC Adapter Cable

 

7196 Printer 
The 7196 Printer is a high speed, high-resolution printer, capable of 
both text and graphics printing. It receives its power from an external 
power supply, has a serial interface and a connector for cash drawers. 

Power Supply

AC Adapter Cable

17302a
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Customer Displays 

NCR 5974 Remote 4x20 Customer Display 
The NCR 5954 Customer Display supports four lines of twenty 
5 x 7 characters. It receives its power from an external power supply, 
uses the parallel interface, and has an eight-inch post mount. 

20119

Power Supply

AC Adapter Cable
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NCR 5973 International VFD Customer Display 
The NCR 5973 VFD (Vacuum Fluorescent Display) is a 256 x 64 graphic 
display for international character sets. It receives its power from an 
external power supply, uses the parallel interface, and is available with 
a Remote Desktop Mount or a 16-inch High-Post Mount. 

20286

Power Supply

AC Adapter Cable
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Cash Drawers 
All cash drawers offered with the RealPOS 80 include a cable with a 
RJ-11 connector for connection to the cash drawer port on any retail 
printer featuring a RJ-11 cash drawer kick out (CDKO) port. 

2189 Cash Drawer 
The 2189 Cash Drawer is a full-size cash drawer designed for medium 
to high transaction environments. 

Other Cash Drawers 
While the 2189 Cash Drawer is the advocated solution, the following 
alternate drawers are available for remote configurations where 
smaller form factor is required. 

• 2183 Mid Range Cash Drawer 

• 2113 Compact Cash Drawer 

Third-Party Cash Drawers 
For compatibility with NCR POS terminals and printers, cash drawers 
must meet the following requirements: 

• The cash drawer interface must match the NCR CDKO interface 
with RJ45 connector. 

• The cash drawer kick-out solenoid must be designed for a 24V, 1A 
pulse of duration 100msec. 

• The cash drawer must include a back-emf protection diode (1A, 
200PIV) across the solenoid, to prevent damage to the printer or 
motherboard circuitry. 
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Other Integrated Devices and Indicators 
Hard Disk Drive 
A 3.5-inch IDE hard disk is a standard type that is used by notebook 
PCs. 

Power Status LED 
The LED power indicator indicates whether power is present at the 
processor board or not. The LED is green when the processor and BIOS 
are operating properly. The LED is located on the right side of the 
chassis as illustrated. 

To power down the terminal, press the Power button on the side of the 
terminal. If the Instant Power Off setting in BIOS Setup is set to Disabled 
you must press and hold the power off button for 4-5 seconds.   

20282

Power Status LED
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LAN Status LEDs 

LAN Integrity
(Green)

LAN Speed:
  Yellow=100MB
  OFF=10MB 20120  

Power Supply 
Note: The power supply DOES NOT automatically sense the proper 
AC voltage; therefore, the switch on the back must be set prior to 
installation. 

All power required to operate the base unit and bus-powered USB 
peripherals is provided by the power supply. 

The Processor board serves as the hub to distribute power to all 
terminal functions. The Cash Drawer, integrated VFD Customer 
Display, PS/2 Keyboard, Mini PCI slot, Scanner (through RS-232 port), 
USB, hard disk, and the LCD all receive power through their respective 
processor board connectors. 

NCR Power Management 
APM is disabled in BIOS by default, therefore, the user must enable 
this feature and the system must be configured with an APM driver 
(such as Power.exe for DOS or vpowerd.386 for Windows 3.x) in order 
for the system power saving features to take effect. 

The processor board is designed with different software-controlled 
power states. This permits different parts of the system to be powered 
down by the power management software in the BIOS.  

Note: APM is only supported under Windows 2000 
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Definitions of the Power States 
1. OFF:  AC power is not present. All RAM contents are lost. 

2. ON:  Power is on and fully supplied to all 7460 components. The 
display and touch panel are active. The CPU may be fully on or be 
in chip standby mode. This is transparent to the user and the 
application. Standby mode reduces power requirements and is 
controlled by the chip set and is entered/exited depending on the 
CPU’s utilization level. Transitioning between fully on and stand 
by causes no delay. 

3. CONSERVE:  Power is on, but throttling back or completely 
stopping the system clock reduces consumption. Throttling is fully 
programmable. This is the primary means of reducing system 
power consumption and is used to help correct a high temperature 
warning level detected by the temperature monitor. Temperature is 
also be reduced by dimming the LCD. There is no user or 
application action required for this mode. When a Safe Temperature 
is detected, the system will switch back to the ON state. 
Transitioning between ON and CONSERVE takes less than 10 
milliseconds. 

4. SOFT OFF:  Temperature has reached a critically high level, a LAN-
based Powerdown was received, or a system Shutdown occurred. 
Power consumption is reduced to its lowest level. All voltages are 
still present, but BIOS places each peripheral and chip into its 
lowest available power state. The chip set enters the Suspend-to-
RAM mode. The LCD back light is turned off, blanking the display. 
RAM contents are preserved upon return to ON state unless 
software issues a reset. If this state was entered because of a LAN-
based Powerdown or system Shutdown, transitioning to the ON state 
can occur via LAN-based reset or wakeup, Timer wake-up, Touch 
activity, or keyboard. If SOFT OFF was entered because of a 
Critical Temperature, the ON state can be automatically 
transitioned to when a Safe Temperature is reached. 

Note: Support for wake-on-ring from SOFT OFF state has been 
removed as a feature. 
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Operating System Support 
The following table shows what is expected during a system shutdown 
for each type of operating system.   

Windows 2000 

Power Savings 
Enabled 

Power Savings 
Disabled 

OS APM 
Enabled 

OS APM 
Disabled 

Result 

√  √  Shutdown in 
SOFTOFF Mode 

√   √ Shutdown to Safe to 
Shutdown screen 

 √ √  On Shutdown 
machine restarts (*) 

 √  √ Shutdown to Safe to 
Shutdown screen 

(*) This is a BIOS restriction 

 

Windows NT (**) 

Power Savings 
Enabled 

Power Savings 
Disabled 

NCRSYSM 
Installed 

NCRSYSM 
Not Installed 

Result 

√  √  Shutdown to Safe to 
Shutdown screen, then 
goes into SOFTOFF 

√   √ Shutdown to Safe to 
Shutdown screen 

 √ √  Shutdown to Safe to 
Shutdown screen, then 
goes into SOFTOFF 

 √  √ Shutdown to Safe to 
Shutdown screen 

Note: APM is only supported under Windows 2000 
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Windows 98 (**) 

Power Savings 
Enabled 

Power Savings 
Disabled 

OS APM 
Enabled 

OS APM 
Disabled 

Result 

√    Shutdown in 
SOFTOFF Mode 

 √   Shutdown 
completely, did not 
enter SOFTOFF 

Note: APM is only supported under Windows 2000 

Wake on Touch Restriction 
If a shutdown is performed with APM Disabled, , the message Press 
the power button to turn the system off is display. The system is turned off 
by pressing the power switch. 

If a shutdown is performed with APM Enabled, you must still press 
the power switch to reboot the Operating System. Touching the screen 
does not reboot the system. 

Note: The NCR Gold images are built with APM Disabled in the 
Operating System. 

 



 

Chapter 2:  Hardware Installation 

Introduction 
The terminal is fully assembled at the factory. This chapter explains the 
mounting options and how to connect optional hardware components 
to the terminal. 

Installation Summary 
The terminal should be removed from the shipping packaging and 
visual checks made to verify the correct hardware configuration. The 
system is then configured and any communication cables are 
connected. 

Caution: The power supply in this unit must be set to match the 
proper voltage requirements (115V or 230V). The AC Selector switch is 
located behind the Front Panel. The switch must be set before plugging 
the power cord into an AC outlet. Refer to the Accessing the Cable 
Connectors and Routing Cables section for instructions how to remove 
the Front Cover. 

20623

115

AC Voltage 
Selector

115
230

 
ROM-based setup should be used to configure network options. Full 
configuration depends upon the system server and the management 
web site. 
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Installation Restrictions 
• Before installing the terminal, read and follow the guidelines in the 

NCR 7460 Retail Terminal Site Preparation Guide (B005-0000-1281) 
and the NCR Workstation and Peripheral AC Wiring Guide  
(BST0-2115-53). 

• Install the terminal near an electrical outlet that is easily accessible. 
Use the power cord as a power-disconnect device. 

• Do not permit any object to rest on the power cord. Do not locate 
the terminal where the power cord can be walked on. 

• Use a grounding strap or touch a grounded metal object to 
discharge any static electricity from your body before servicing the 
terminal. 

• If the power cord is replaced, it must be replaced with the same 
type of cord with the protective shroud. 

• Do not route the power cord through openings with sharp edges. 

Caution: This unit contains hazardous voltages and should only be 
serviced by qualified service personnel. 

Caution: DO NOT connect or disconnect the transaction printer while 
the terminal is connected to AC power. This can result in system or 
printer damage. 

Warning: If wall mounted, the NCR 7460 must be mounted securely 
to prevent a hazard. It must be installed in accordance with local 
building codes. The wall on which the unit is mounted should be 
able to withstand four times the weight of the unit, which is 
approximately 16 lbs. 2oz. (7.3 kg) for the complete unit and 6 lbs. 
(2.7kg) for the operator display . 
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Connecting the Cables 
Cable connectors are located on the chassis behind the Front Cover. 

Accessing the Cable Connectors and Routing Cables 
1. Remove the Front Cover 

a. Elevate the front of the unit and rotate the Latch Plates as 
shown below. The Latch Plates are used to hold the Front Cover 
in position. 

b. Slide the Front Cover down to disengage it from the chassis. 

Note: Some models are configured with a Front Mounted 
MSR. In that case you also have an MSR cable to disconnect. 

20142

Latch Plates

Front Cover
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Cable Connectors 

Terminal Cable Connectors 
The following illustration identifies each of the cable connectors. Refer 
to the sections following the illustration for specific instructions on 
installing each peripheral.  

20117

AC Voltage 
Selector

AC Power Parallel
Port

DVI
Display

MSR Cash
Drawer

LAN

USB

Keyboard ModemCom1

Com2
(Powered)

Com4
(Serial Port D,

Powered)

VGA

Com3
(Serial Port C,

Powered)

Audio

 

MSR Connections 
The MSR connection varies, depending on which MSR is present. 

Front Mounted MSR – connects to the MSR connector behind the Front 
Panel (shown above). 

Side Mounted MSR – uses the Wedge interface through the display head 
to the PS/2 keyboard connector. The MSR connector is not used. 
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Operator Display Cable Connectors 

Wedge
Scanner

PS/2
Keyboard

RS-232

DVI

19454a
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Installing Peripherals 

Installing a Transaction Printer 
The printer can connect through a USB connector or an RS-232 
connector. It receives power from an external power supply. 

Interfaces Supported 
Printer USB RS-232 

7167 √ √ 
7196  √ 
7197 √ √ 

In order to use the USB interface the I/O Networks USB to RS-232 
drivers must be used. These drivers are found in the C:\install 
directory of the OS Recover image or on the NCR Drivers and Patches 
web site.  
http://www.ncr.com/support/support_drivers_patches.asp?Class=retail. 
Under Windows 98, if the I/O Networks drivers are installed after the 
NCR Retail Platform for Windows OPOS Drivers, the system will hang 
on restart. If a shutdown is done there is no problem. This only occurs 
after installation. All subsequent restarts and shutdowns perform as 
expected. If OPOS is installed after the I/O Networks drivers, this does 
not occur. 

Note: edgeser.sys (V 2.17 or later) is required for support of the 
7197/7167 printers. Otherwise a General Protection Fault will occur. 
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USB Printer Installation 
1. Connect the USB Printer Interface Cable to the USB Connector on 

the printer and the terminal. 

2. Connect the Power Supply to the Power connector on the Printer 
and to a standard AC outlet. 

20118

Power

USB

USB

497-0415949 - 1 m
(1416-C528-0010)

497-0415950 - 4 m
(1416-C528-0040)

AC Power Supply
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RS-232 Printer Installation 
1. Connect the RS-232 Printer Interface Cable to the RS-232 Connector 

on the printer and to an RS-232 Connector on the terminal. 

2. Connect the Power Supply to the Power connector on the Printer 
and to a standard AC outlet. 

COM2

COM1

COM4

COM3

20121

Power RS-232

RS-232

497-0408349 - 0.7 m
(1416-C359-0007)

497-0407943 - 4 m
(1416-C266-0040)

497-0409379 - 15 m
(1416-C266-0150)

Power Supply

7158, 7194, 7167, 7197

7196
497-0407427 - 1.0 m
(1416-C337-0010)

497-0407429 - 4 m
(1416-C337-0040)

497-0407430 - 15.2 m
(1416-C337-0152)
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Installing a Remote Customer Display 
There are two Remote Customer Displays supported. The installation 
procedures are identical. 

20285
5973 International Customer Display

5974 Remote Customer Display

 
1. Locate the Display Mount within 4 meters (13 ft.) of the host 

terminal. 

2. Determine if the cable should be routed down through the 
mounting surface or if it should be run on top of the surface. Drill a 
hole if necessary. 
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3. Secure the Mounting Plate with the provided screws (4). 

16258a

Mounting Plate
4 Holes
4.06 mm

(0.160 in.)
Diameter

76 mm
(3 in.)

 
4. Connect the 5974 Display Cable to the Parallel port on the terminal. 

20284

Power Supply

Parallel Port

5. Connect the Power Supply to the Power pigtail on the cable and to a 
standard AC outlet. 
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Installing a Cash Drawer 
1. Place the cash drawer in the desired location, within cable length of 

the terminal. 

2. Connect the cash drawer cable to the terminal cash drawer 
connector. 

20287

Cash Drawer

Optional
Connection

 
 

Note: The Cash Drawer can optionally be connected to the printer. 
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Installing a Keyboard and Mouse 
The 7460 supports a PS/2 keyboard connected to the PS/2 connector in 
the Operator Display assembly. The PS/2 mouse requires a Y-cable to 
be installed at the terminal PS/2 connector as shown below. 

20296

PS/2

497-0406056
(1416-C281-0018)

PS/2
RS-232

RS-232 PS/2

Operator Display

497-0425664
(1416-C800-0004)
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Installing a Serial Mouse 
Follow these steps to install a Serial Mouse on the terminal.  

Edit the boot.ini file, which is located in the root of the C drive. 

Note: The procedures below vary slightly, depending on which 
Operating System is being used. 

1. Open Windows Explorer 

2. Go to the Tools menu and select Folder Options. 

3. Select the View tab. 

4. Scroll down until you see a folder that is labeled Hidden Files. Make 
sure the button labeled Show hidden files and folders is selected 
and then select OK. 

5. Select the C drive root directory. Scroll down until you find the file 
named boot.ini and select it. 

6. Open the File menu and then select Properties. 

7. Uncheck the box labeled Read Only and then select OK. 

8. Open the boot.ini file with Notepad. It should have the 
following entry: 
[operating systems] 
multi(0)disk(0)rdisk(0)partition(1)\WINNT="Windows NT 
Workstation Version 4.00" /NoSerialMice 

9. Delete the text /NoSerialMice. 

10. Save the file and then restart the terminal with the serial mouse 
connected. 

After the machine restarts it sees the mouse and installs the supporting 
drivers. The drivers are located on the hard drive at C:\install\i386. 
If for some reason they are not on the hard drive, connect the terminal 
to a network and share a CD-ROM drive with the NT Operating 
System disk installed, or copy the files needed to the network. 
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Touch Screen 

Touch Interface BIOS Setting 
The touch screen for has a dedicated serial interface (COM3), which 
means that any serial peripheral device using COM3 must be changed 
to use a different port. The Powered Port option for COM3 (Serial Port 
C in the BIOS Setup, see Chapter 3: BIOS Setup), MUST be set to Auto 
for the Touch Interface to function. 

Calibrating the Touch Screen 
Be sure to observe for the following touch screen calibration 
guidelines: 

• Calibrate the touch screen as part of the installation process. 

• Recalibrate the touch screen when the system is installed at its final 
location. 

• Recalibrate whenever the terminal is moved to a new location. 

• Recalibrate the touch screen anytime the system has been 
disassembled for servicing. 

• Recalibrate the touch screen if the screen resolution is changed. 

The touch screen can be calibrated using MicroTouch (Windows) or 
Microcal (DOS). 
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Calibration Using TouchWare (Windows) 
1. From the Windows Start button, select Settings→Control 

Panel→TouchWare. 

2. From the TouchWare Properties screen, select Calibrate to begin 
calibration. 
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3. A screen is displayed with five targets. Place your finger on the 
target that has a finger icon pointing towards it and hold it until the 
statement Touch Enable is displayed over the finger icon.  

Note: For best results, press the screen near the circle and then 
slide your finger onto the circle without raising your finger from 
the screen. 

 
4. Repeat the touch procedure for the remaining icons. 

Place  your 
finger here 
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5. When the MicroTouch Calibration dialog box reappears, do not 
touch the screen until this dialog box is no longer displayed. 

 
6. From the Calibration Complete screen, select Done. 

7. Select Close to exit the TouchWare program. 

8. From the Control Panel, select File→Close to exit the Control 
Panel.  

Note: For more information on the MicroTouch TouchWare software, 
please refer to the User’s Guides that are on the NCR 74xx Base System 
and Client Third Party Drivers CD (LPIN:  D370-1111-0100), or on the 
NCR Drivers and Patches web site. 

http://www.ncr.com/support/support_drivers_patches.asp?Class=retail. 
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Calibration Using Microcal (DOS) 
The calibration program looks at where your finger is when you lift it 
off the screen, not where you touch it. Therefore, calibrate the screen as 
follows: 

1. Touch the screen near the calibration target. 

2. Keep your finger on the screen and slide it to the center of the 
target. 

3. Hold your finger firmly on the target for two seconds, then lift it off 
quickly. 

4. Verify that the calibration was set accurately before making a 
service call. Perform the calibration again if necessary. 

Noise Check Utilty 
If cursor is not stable, or false touches are suspected, run the Noise 
Check Utility from the Microcal program (found on the NCR 74xx Base 
System and Client Third Party Drivers CD (LPIN:  D370-1111-0100). 
Choose the recommended frequency (the one with the lowest noise 
level). This should also be done if the touch screen is still not calibrated 
after one attempt to recalibrate it. 

1. Set the video resolution by going to the Tools menu, Video and 
selecting 800 x 600 256 colors. 

2. Go to the Tools menu, select Noise Check. 

3. Follow the instruction prompts. Choose the frequency with the 
lowest noise level. 

Application software can possibly generate a dialog box from the 
Touch Driver, with the message that the touch screen needs to be 
recalibrated. If the screen appears to be working normally, then this 
message can be ignored. There is a check box labeled Do not show 
this message again. Make sure this box is checked. 
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Summary 
If there is a touch screen calibration issue during or after installation, 
take the following actions in the order listed: 

1. Recalibrate. 

2. If recalibration is unsuccessful after two attempts, then run the 
Noise check to change the frequency. 

3. If you are still unable to calibrate, change the touch screen glass. 

4. The final step is to replace the Touch Controller Board. If this 
corrects the problem, then the old glass is probably OK to reuse. 

Double-Touch Condition 
There are instances where Touchscreen settings can permit duplicate 
touches from operators. If you experience this condition make the 
following changes. 

1. From the Windows Start button, select Settings→Control 
Panel→TouchWare. 

2. From the TouchWare Properties screen, select Touch Settings. 

3. In the Touch Mode section select Button (Green Light should 
illuminate). 

Note: If Button is not one of the selections available but there is a 
Custom button available, go to the Tools tab, select 
Options→Button mode (default), and Close. 

4. In the Double-click section set the Double-click to the slowest 
setting. 

5. Test the Touchscreen by selecting the Draw option under the Tools 
tab. 

6. Exit the TouchWare Utility. 
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MSR Cleaning Cards 
Part Part Number 

MSR Cleaning Card, Dry 998-0052929 
MSR Cleaning Card, Wet 603-9004998 

Out-of-Box Failures 
The RSG-Atlanta Customer Satisfaction Hotline will replace out-of-box 
failed hard disks with identical, preloaded drives. Once a system is 
successfully installed, all disk contents are the responsibility of the 
customer. The customer is responsible for restoring operating system 
software and/or customer-specific data onto replacement disks sent to 
repair a failed or damaged disk in the field. NCR provides recovery 
tools for the operating system and platform software. 

Powering Down the Terminal 
To power down the terminal, press the Power button on the side of the 
terminal. If the Instant Power Off setting in BIOS Setup is set to Disabled 
you must press and hold the power off button for 4-5 seconds.   

Note: If the unit is powered on and you pull the plug from the power 
source and then plug it back in, the unit comes back on. If the unit is 
powered off and you unplug it from its power source, then plug it back 
in, the unit is still powered off. To disable this feature change the BIOS 
setting After Power Failure in the Advanced menu. 

 



 

Chapter 3:  BIOS Setup 

Introduction 
Since the Setup Utility supports touch input, an external alphanumeric 
keyboard is not required. However, it is recommended for ease of use. 

Note: The BIOS version required is Version 2.0.0.0. 

Entering Setup Using a Keyboard 
1. Apply power to the terminal. 

2. Press the F2 key when the message at the bottom of the screen 
prompts you to do so. 

Note: Setup can also be entered from the Boot Menu that is 
displayed when you press ESC during POST. 

Entering Setup Using the Touch Screen 
1. Apply power to the terminal. 

2. Calibrate the touch screen. 

a. When the screen prompt that says Touch the screen two times to 
enter Setup appears, touch the screen three times. This causes 
the system to bypass the BIOS Setup and go directly to the 
Touch Screen Calibration Setup. You will not see this prompt if 
the Boot-Time Diagnostics Screen is disabled, but you can still 
enter setup by touching the screen three times. 

b. As instructed on the screen, touch the circle near the lower-left 
corner of the screen. For best results, press the screen near the 
circle and then slide your finger onto the circle without raising 
your finger from the screen. 

c. Using the same method as above, touch the circle near the 
upper-right corner of the screen. 
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3. You should receive a Successful Calibration message and then the 
PhoenixBIOS Setup Utility should come up. 

4. Select the setup parameters by touching the controls at the bottom 
of the screen. 

How to Select Menu Options 
The following keyboard controls are used to select the various menu 
options and to make changes to their values. 

• Use the arrow keys to select (highlight) options and menu screens. 

• Use the + and - (or F5 and F6) keys to change field values. 

• To view help information on the possible selections for the 
highlighted item, press F1. 

• To save the changes, move the cursor to the Exit Menu, select either 
Save Changes & Exit or Save Changes, and press Enter. 

Note: If you are not using an external keyboard, you can touch the 
menu controls at the bottom of the screen. If you encounter difficulty 
doing this, recalibrate the screen. 

Restoring Factory Settings 
To reset all values to their default settings for the current screen, press 
F9. The terminal will automatically load BIOS default CMOS values for 
boot up. 

To reset all BIOS settings to their default settings go to the Exit menu, 
press F9, select either Save Changes & Exit or Save Changes, and press 
Enter. 

See the BIOS Default Settings section later in this chapter for the pre-
installed Setup defaults. 

BIOS Default CMOS Values  
The following are the BIOS default CMOS values for the terminal.  
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Main Values 

System Time (variable) 

System Date (variable) 

Legacy Diskette A: [Disabled] 

Primary Master [Auto] 

 Total Sectors: (variable) 

 Maximum Capacity: (variable) 

 Multi-Sector Transfers: (variable) 

 LBA Mode Control: [Enabled] 

 32 Bit I/O: [Disabled] 

 Transfer Mode: Fast PIO 4 

 Ultra DMA Mode: [Mode 2] 

Primary Slave [Auto] 

 Type: [Auto] 

 Multi-Sector Transfers: [Disabled] 

 LBA Mode Control: [Disabled] 

 32 Bit I/O: [Disabled] 

 Transfer Mode: [Standard] 

 Ultra DMA Mode: [Disabled] 

 Smart Monitoring: Ensabled 

System Memory 640  KB 

Extended Memory (variable) 
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Advanced Menu 

Installed O/S: [Other] 

Reset Configuration [No] 

Memory Cache [Enabled] 

 Cache System BIOS area [Write Protect] 

 Cache Video BIOS area [Write Protect] 

 Cache Base (0-512k) [Write Back] 

 Cache Base (512-640k) [Write Back] 

 Cache Extended Memory area [Write Back] 

 Cache A000 – AFFF: [Disabled] 

 Cache B000 – BFFF: [Disabled] 

 Cache C800 – CBFF: [Disabled] 

 Cache CC00 – CFFF: [Disabled] 

 Cache D000 – D3FF: [Write Protect] 

 Cache D400 – D7FF: [Write Protect] 

 Cache D800 – DBFF: [Write Protect] 

 Cache DC00 – DFFF: [Write Protect] 

 Cache E000 – E3FF: [Write Protect] 

 Cache E400 – EBFF: [Write Protect] 

 Cache EC00 – EFFF: [Write Protect] 

PS/2 Mouse [Auto Detect] 

I/O Device Configuration  

Serial port A: [Enabled] 

 Base I/O address: [3F8] 

 Interrupt: [IRQ 4] 
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Serial port B: [Enabled] 

 Base I/O address: [2F8] 

 Interrupt: [IRQ 3] 

 Powered Port: [Auto] 

LPT 1: [Enabled] 

 Mode [ECP] 

 Base I/O address: [378] 

 Interrupt: [IRQ 7] 

 DMA channel: [DMA 1] 

 Fdc On Lpt: [Auto] 

Floppy disk controller:  [Disabled] 

Serial port C: [Enabled] 

 Base I/O address: [3E8] 

 Interrupt: [IRQ 10] 

 Powered Port: [Auto] 

Serial port D: [Enabled] 

 Base I/O address: [2E8] 

 Interrupt: [IRQ 11] 

 Powered Port: [Auto] 

LPT 2: [Enabled] 

 Mode [ECP] 

 Base I/O address: [278] 

 Interrupt: [IRQ 5] 

 DMA channel: [DMA 3] 

Disk-On-Chip: [Disabled] 
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MSR Address: [DE00-DFFF] 

Large Disk Access: [DOS] 

Local Bus IDE adapter: [Primary] 

Advanced Chipset Control 

 Video boot type [Enabled] 

 Extended memory gap [Disabled] 

PCI Configuration  

PCI/PNP ISA UMB Region Exclusion  

 Cache C800 – CBFF: [Available] 

 Cache CC00 – CFFF: [Available] 

 Cache D000 – D3FF: [Available] 

 Cache D400 – D7FF: [Available] 

 Cache D800 – DBFF: [Available] 

 Cache DC00 – DFFF: [Available] 

PCI/PNP ISA IRQ Resource Exclusion  

 IRQ 3: [Available] 

 IRQ 4: [Available] 

 IRQ 5: [Available] 

 IRQ 7: [Available] 

 IRQ 9: [Available] 

 IRQ 11: [Available] 

 IRQ 15: [Available] 

PCI IRQ Line 1 [Auto Select] 

PCI IRQ Line 2 [Auto Select] 

PCI IRQ Line 3 [Auto Select] 
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PCI IRQ Line 4 [Auto Select] 

System Monitors  

 +12V Status Current value of the indicated 
measurement (continuously updated) 

 +2.5V Status Current value of the indicated 
measurement (continuously updated) 

 +5V Status Current value of the indicated 
measurement (continuously updated) 

 CPU Temperature Current value of the indicated 
measurement (continuously updated) 

 System Temperature Current value of the indicated 
measurement (continuously updated) 

 Vcc Status Current value of the indicated 
measurement (continuously updated) 

 Vcore Status Current value of the indicated 
measurement (continuously updated) 

 1.8V Status Current value of the indicated 
measurement (continuously updated) 

 Vtt Status Current value of the indicated 
measurement (continuously updated) 

 +3.3V Status Current value of the indicated 
measurement (continuously updated) 

Multiple ROM  

 Parallel CD-ROM Boot [Disabled] 

 On-board Intel PXE [Enabled] 

 On-board Intel LAN [Enabled] 

 Etherboot [Disabled] 

 Selectable ROM 5 [Disabled] 
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 Selectable ROM 6 [Disabled] 

 Selectable ROM 7 [Disabled] 

 Selectable ROM 8 [Disabled] 

 Selectable ROM 9 [Disabled] 

 Selectable ROM 10 [Disabled] 

 Selectable ROM 11 [Disabled] 

 Selectable ROM 12 [Disabled] 

 Selectable ROM 13 [Disabled] 

 Selectable ROM 10 [Disabled] 

 Selectable ROM 15 [Disabled] 

Quickboot Mode: [Enabled] 

After Power Failure [Enabled] 

Continuous POST: [Disabled] 

Boot menu retry: [Keyboard] 

Instant Power Off [Enabled] 

LCD Contrast: [ 25 ] 

LCD Brightness: [ 3 ] 

Beep Error Codes: [Off] 
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Security Menu 

Supervisor Password Is: Clear 

User Password Is: Clear 

Set Supervisor Password: [Enter] 

Set User Password: [Enter] 

Password on boot: [Disabled] 

Power Menu 

Power Savings: [Disabled] 

Standby Timeout: [Off] 

Auto Suspend Timeout: [Off] 

Hard Disk Timeout: [Disabled] 

Resume On Time: [Off] 

Resume Time: [00:00:00] 

Resume On Modem Ring: [Off] 

Boot Menu 

Intel® Boot Agent Version 4.0.17:  

+Hard Drive  

CD-ROM Drive  

Removable Devices  
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Chapter 4:  Operating System Recovery 

Introduction 
This chapter discusses procedures how to recover the Operating 
System by using the parallel CD-ROM drive. The software is 
distributed on bootable CD-ROM media. The drivers that are necessary 
to run the CD-ROM are temporarily installed during boot. 

Prerequisites 
The following are required on the 7460 in order to perform a OS 
Recovery using a CD. 

• Bootable CD-ROM drive (2336-K024) 

• Keyboard 

Caution: When performing an OS recovery from a larger source 
image (larger disk) to a smaller destination disk you must use a special 
procedure. See the section titled OS Recovery from a Larger Disk Image. 
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Updating Procedures 
1. Connect the external CD-ROM (2336-K024) drive to the parallel 

port on the terminal. 

2. Connect the opposite end of the CD-ROM cable power connector to 
the CD-ROM drive parallel connector. 

Note: The parallel port on the 7460 is the Remote Customer 
Display port. Therefore, if your terminal is configured with a 
Customer Display, you must temporarily disconnect it in order to 
use the CD-ROM drive. 

Parallel Connector

Power
Connector

Parallel Port

18532  
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3. Connect the DC Power Cable to the CD-ROM power connector and 
an AC outlet. 

4. Insert the CD that contains the operating system image in the CD-
ROM drive.  

Software CD LPINs 

Win2000 WinNT Win98 DOS 
D370-0562-0100 D370-0561-0000 D370-0559-0100 D370-0499-0100 

5. Apply power to the terminal. 

6. Press F2 at the screen prompt to enter the Setup Utility. 

7. In the Advanced menu, select Multiple ROM Menu. 

8. Set the Parallel CD-ROM Boot to Enabled. 

9. In the Advanced menu, select I/O Device Configuration. 

10. Verify the LPT1: is set to ECP. 

11. Exit Setup and Save Changes. 

As the terminal reboots, you should see a message during boot 
indicating that the CD-ROM has been recognized: 

Micro Solutions BACKPACK CD-ROM v0.3 
. . . 
Booting from BACKPACK CD 
Starting MS-DOS 

12. Follow the DOS screen prompts. After each entry, you are asked to 
confirm your input. You can use 1 or y for Yes, 2 or n for No. 

13. Enter whether or not you want to perform Disk Verification. 
(Answering Yes takes twice as long, but is recommended.) 

If Yes is selected: 

• The Ghost software verifies write operations and handles 
bad FAT clusters. 

• The Ghost error file (GHOST.ERR) is displayed before 
rebooting 
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If No is selected: 

• The Ghost error file is displayed before rebooting only if 
Ghost aborts. 

Caution: If the error file is displayed, the batch file pauses for 
user input before rebooting. You may use Ctrl-C to cancel out of 
the batch file if you want to see the error file again, but nothing 
should be done that writes to the hard disk before rebooting. 
GHOST.ERR is on the RAM disk and is lost on reboot. 

14. Select which type of recovery you want to perform from the next 
menu (normally option #1). 
1. Redo entire disk with the first partition the same size. 
2. Redo the first OS partition. 
3. Redo the second OS partition. 

The Ghost software then begins the disk recovery from the CD. It 
displays a progress bar and gives you an estimate how long the process 
should take. 

Note: Some Operating Systems occupy more than one CD. You 
are asked to insert the next CD at the proper time. 

When the recovery process is completed, the client hard disk is 
restored to its preinstalled condition, as originally received from the 
factory. 

15. Remove the CD from the drive. 

16. Enter Setup when the terminal reboots and reset the Parallel 
CD-ROM Boot to Disabled. 

17. Exit Setup and Save Changes. 

Completing the OS Installation (Win2000) 
The system automatically reboots when the image recovery is complete 
and starts the software installation. This installation also installs most 
of the additional software and drivers that are included in the disk 
image. Complete the installation as follows. 
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1. After the terminal reboots, it will perform a disk check and then 
continue with the Windows 2000 installation. 

2. Enter the User Name and Organization. 

3. Enter the Computer Name for the client. 

4. Enter the Administrator’s Account Password (optional) 

5. Login when prompted. 

6. Run the TouchWare calibration from the Desktop icon. 

Completing the OS Installation (WinNT) 
The system automatically reboots when the image recovery is complete 
and starts the software installation. This installation also installs most 
of the additional software and drivers that are included in the disk 
image. Complete the installation as follows. 

1. After the terminal reboots, it will perform a disk check and then 
continue with the Windows NT installation. 

2. Enter the User Name and Organization. 

3. Enter the Computer Name for the client. 

4. Enter the Administrator’s Account Password (optional) 

5. Log in when prompted. 

6. Press Next at the Found New Hardware wizard. 

7. Run the TouchWare calibration from the Desktop icon. 

Completing the OS Installation (Win98) 
The system automatically reboots when the image recovery is complete 
and starts the software installation. This installation also installs most 
of the additional software and drivers that are included in the disk 
image. Complete the installation as follows. 

1. When the terminal boots it enters the Windows setup routine. 

2. At the User Information screen, enter the User information. This 
can be done using a keyboard or you can use the touch screen. 
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3. Go into the Control Panel and set the terminal Date and Time. 

4. Run the TouchWare calibration from the Desktop icon. 

Completing the OS Installation (DOS) 
The system automatically reboots when the image recovery is complete 
and opens at the DOS C: prompt. 
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Gold Disk Contents 
This section describes the contents of each of the Gold Disk Images, 
including all the additions and changes that was made on top of the 
generic operating system. 

Important:  For each operating system, NCR strongly recommends that 
the drivers placed in the c:\install directory be left there for the 
purposes of servicing and maintaining the system. If you are using the 
information in this section to build your own operating system image 
and not using NCR’s provided OS Recovery image as a base image, 
then we recommend that all installed drivers be placed in a similar 
c:\install directory for support. 

Microsoft Operating System License Agreements 
When purchasing a workstation preloaded with a Microsoft operating 
system, the application provider must follow certain license agreement 
guidelines. Listed below are some of the major points of Microsoft’s 
Embedded Software agreement, which currently covers DOS, Win 3.11, 
Windows 98, Windows NT, and Windows 2000. 

• The end user application should not allow the user (typically a 
cashier) to exit the application so that they may be able to browse 
the operating system desktop, explorer, or other Microsoft 
operating system user interface elements. This does not apply to 
servicing, upgrading, or diagnosing problems for the workstation 
by services or field engineers. This restriction is meant to ensure 
that the end user is only allowed to navigate within the confines of 
the end user’s application under normal operating conditions. 

• The NCR OS Recovery image can only be used to recover or update 
systems with licenses procured from NCR. 
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Migrating Operating System Images from 7460 1.x Terminals 
In the sections that follow are listed the items that NCR has installed 
for the images for Release 2.0. Those items that are marked in Bold are 
required changes that MUST be done to the 1.x image in order for the 
new hardware to function properly. All other changes to the image are 
optional. 

NCR 7460 Win 2000 Operating System Recovery Software 
(LPIN: D370-0562-0100) 

Installed Software 
• Microsoft Windows 2000 Professional with SP2 

• Microsoft Windows 2000 SRP1 

• Microsoft Internet Explorer 6.0 (6.0.2600.0000) 

• Intel AC'97 Audio (5.0.2184.1) 

• Intel(R) 82810 Video (5.12.1.2772) 

• Intel(R) 82559 Fast Ethernet LAN (5.0.67.0) 

• Intel 810 Ultra ATA Storage (6.03.008) 

• MicroTouch TouchWare (5.63 SR3) for serial interface (*) 

• Windows Installer (2.0) 

• NCRSYSM (3.0.1.9) 

• Backpack CD-Rom available (3.02) 

• Edgeport USB available (1.16.9) 

(*) All previous versions of MicroTouch must be uninstalled before 
reinstalling support for the serial touch interface. 
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Uninstalled Drivers 
The following drivers are not installed automatically, but can be 
installed from their respective locations (Readme files exist in these 
locations): 

• Backpack CD-ROM C:\Install\Drivers\CDRom 

• Edgeport USB C:\Install\Drivers\USB 

Settings and Revisions 
• 1. Preinstalled W2K to include the Product ID Number (PID) 
• 2. Placed the Gold Drive Part Number, Date Created, LPIN, and 

Release in Registry under: 
HKey-Local_Machine\Software\NCR\Gold Drive 

• 3. Ran Sysprep, using sysprep.inf and sysprep.bat, so that the mini 
installation will run on initial boot with the following parameters: 

Automatically include PID 

• Established a single FAT32 primary system partition to fill the 
entire drive 

• Included necessary OS cab files in C:\Install 
• Installed Intel Proset utility 
• Enabled PME set to 'Hardware Default' 
• Disabled APM 
• Used noguiboot to hide OS splash 
• Removed Secondary Controller from IRQ 15 (ATA)After installing 

Windows 2000 the Backpack CD-ROM is not recognized as a boot 
device. It is recognized as a device on the system, but not a 
bootable device. When bootable media is inserted, errors such as 
Operating System Not Found are reported. To correct this condition 
set the BIOS to the Default Parameters. See the Setup chapter, Exit 
Menu Options section. 

Note: This product should only be used on 7460-2XXX terminals with 
a Microsoft Windows 2000 license. 
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NCR 7460-NT Operating System Recovery Software 
(LPIN: D370-0561-0100) 

Installed Software 
• Microsoft Windows NT Workstation 4.0 with SP6a 

• Microsoft Internet Explorer 6.0 (6.0.2600.0000) 

• Microsoft Internet Explorer Security Update (Q323759.exe) 

• Intel(R) 82810-DC100 Video (4.03.1381.2772) 

• Intel(R) 82559 Fast Ethernet LAN (5.00.66.0000) 

• MicroTouch TouchWare (5.63 SR3) for serial interface (*) 

• Windows Installer (2.0) 

• NCRSYSM (3.0.1.9) 

• SoundMax Audio (4.02.00.0053) 

• Intel 810 Ultra ATA Storage (6.10.011) 

• Backpack CD-Rom available (2.04) 

• Edgeport USB available (2.13) 

(*) All previous versions of MicroTouch must be uninstalled before 
reinstalling support for the serial touch interface. 

Uninstalled Drivers 
The following drivers are not installed automatically, but can be 
installed from their respective locations (Readme files exist in these 
locations): 

• Backpack CD-ROM C:\Install\Drivers\CDRom 

• Edgeport USB C:\Install\Drivers\USB 
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Settings and Revisions 
• Preinstalled NT to include the Product ID Number (PID) 

• Placed the Gold Drive Part Number, Date Created, LPIN, and 
Release in Registry under: 
HKey-Local_Machine\Software\NCR\Gold Drive 

• Ran Sysprep (so that the mini installation will run oninitial boot) 
with the following parameters: Automatically include PID 

• Host.cmd set in RunOnce to update the registry 

• Established a 2gb FAT16 primary system partition 

• Established a secondary NTFS partition that fills the remainder of 
the drive 

• Included necessary OS cab files in C:\Install 

• Made SP6a folder available in C:\Install (installed) 

• Exposed to both Intel 82810 and 82810-DC100 video chipsets 

• Installed SMI Control Panel 

• Installed Intel Proset utility 

• Enabled DMA 

• Refresh rate set to 60Hz 

• Set Enable PME to Hardware Default 

Note: This product should only be used on 7460-2XXX terminals with 
a Microsoft Windows NT 4.0 license. 
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NCR 7460-Win98 Operating System Recovery Software 
(LPIN: D370-0559-0100) 

Installed Software 
• Microsoft Windows 98SE 

• Microsoft Internet Explorer 6.0 (6.0.2600.0000) 

• Microsoft Internet Explorer Security Update (Q323759.exe) 

• Analog Devices SoundMax Audio (5.12.01.2502) 

• Intel(R) 82810 Video (4.12.01.2772) 

• Intel 82559 Ethernet LAN (5.00.67.0000) 

• MicroTouch TouchWare (5.63 SR3) for serial interface (*) 

• Windows Installer (2.0) 

• NCRSYSM (3.0.1.8) 

• Intel 810 Ultra ATA Storage (6.10.011) 

• Backpack CD-Rom available (2.04) 

• Edgeport USB available (1.16.9) 

(*) All previous versions of MicroTouch must be uninstalled before 
reinstalling support for the serial touch interface. 

Uninstalled Drivers 
The following drivers are not installed automatically, but can be 
installed from their respective locations (Readme files exist in these 
locations): 

• Backpack CD-ROM C:\Install\Drivers\CDRom 

• Edgeport USB C:\Install\Drivers\USB 
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Settings and Revisions 
• Preinstalled Win98 to include the Product ID Number (PID) 
• Placed the Gold Drive Part Number, Date Created, LPIN, and 

Release in Registry under: 
HKey-Local_Machine\Software\NCR\Gold Drive 

• Added Userinfo.exe to Start Menu to capture User Name, User 
Organization, Computer Name, and Workgroup (once the user has 
entered this information, Userinfo removes itself from the Start 
Menu) 

• Established a FAT32 primary system partition that fills the entire 
drive 

• Included necessary OS cab files in C:\Install 
• Exposed to both Intel 82810 and 82810-DC100 video chipsets 
• Installed Intel Proset Utility 
• Applied a Microsoft hotfix to replace usbhub.sys version 4.10.2222 

with 4.10.2223; this executable has been placed in 
C:\Install\Drivers\USB\Hotfix 

• Set to High Color 

• Enable PME (in Intel Proset utility) set to Hardware Default 

• Muted the Volume Line-In 

• Set refresh rate to 60 Hz 

Note: This product should only be used on 7460-2XXX terminals with 
a Microsoft Windows 98 license. 

NCR 7460 DOS Operating System Recovery Software 
(LPIN: D370-0499-0100) 

The following software is installed on the image: 

• Microsoft DOS installed 
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OS Recovery from a Larger Disk Image 
The following procedure should be used to restore an Operating 
System when the destination disk is smaller than the source image (i.e. 
OS Recovery was made on a 10 GB source disk, but is being recovered 
on a 4.3 GB drive). 

1. Boot the system. 

You should see a message during boot indicating that the CD-ROM has 
been recognized: 

Micro Solutions BACKPACK CD-ROM v0.3 
. . . 
Booting from BACKPACK CD 
Starting MS-DOS 

2. Follow the DOS screen prompts. After each entry, you are asked to 
confirm your input. You can use 1 or y for Yes, 2 or n for No. 

3. Enter No at the Disk Verification question. 

4. Select which type of recovery you want to perform from the next 
menu (normally option #1). 
Redo entire disk with the first partition the same size. 
Redo the first OS partition. 
Redo the second OS partition. 

5. At the Press any key to continue dialog box, press [CTRL-C] to abort 
the process. When asked Terminate batch job?  
Answer Y. 

6. From the command prompt, change to drive Z, which is the 
location of the Ghost software (CD-ROM drive). 

7. Run the Ghost command. 
Ghost.exe  

8. Press Enter. 

9. Select Local → Disk → From Image and press Enter. 
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10. The directory that Ghost is now looking in should be Z: (if not, 
switch to Z). Select the File name to load image from file 
(nnnnnnn.gho) and press Enter. 

11. Select the Local destination drive and press Enter. 

12. Set the size (2gb) of the 1st partition (which is FAT16). In order to 
do this you may need to clear the amount from the 2nd partition. 

13. Set the size of the 2nd partition. 

O/S 2nd Partition 
Format 2nd Partition Size 

Win2000 NTFS Fill the remaining drive space 

NT NTFS Fill the remaining drive space 

Win98 FAT32 Fill the remaining drive space 

DOS FAT16 2gb 

14. Press Enter. 

15. If you are recovering from Win9x, it is likely that the 2nd partition 
will be too small for FAT32. If so, a dialog is displayed 
Converting partition from FAT32 to FAT, proceed?   
Choose Yes. 

16. At the next dialog box, 
Proceed with disk load? Destination drive will be 
permanently overwritten, 
Choose Yes to start the recovery process. 
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Chapter 5:  BIOS Updating Procedures 

Introduction 
This chapter discusses procedures how to update the terminal BIOS by 
using the parallel CD-ROM drive. The software is distributed on 
bootable CD-ROM media. The drivers that are necessary to run the 
CD-ROM are temporarily installed during boot. 

It is also possible to perform a BIOS update using a network 
connection. Refer to the NCR FitClient Software User’s Guide for 
information about that procedure. 

Crisis Recovery 
In the event the BIOS becomes corrupt, such as the result of a power 
failure during the BIOS Update procedure, you can use the method 
discussed later in this chapter in the BIOS Crisis Recovery section to 
recover the BIOS. 

Prerequisites 
The following are required on the 7460 in order to perform a BIOS 
update using a CD. 

• Bootable CD-ROM drive (2336-K024) 

• Keyboard 

• Keyboard NCR BIOS and BIOS Update Software 
(LPIN: A370-0022-0100) (Version 2.0.0.0 or later) 
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Updating Procedures 
1. Connect the External CD-ROM Drive (2336-K024) to the parallel 

port on the terminal. 

Parallel Connector

Power
Connector

Parallel Port

18532  
2. Connect the Power Cable to the CD-ROM power connector and an 

AC outlet. 

3. Insert the BIOS CD in the CD-ROM drive.  

4. NCR BIOS and BIOS Update Software 
LPIN: A370-0022-0100 (Version 2.0.0.0 or later) 

5. Apply power to the terminal. 

6. Press F2 at the screen prompt to enter Setup. 
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7. In the Advanced menu, select Multiple ROM Menu. 

8. Set the Parallel CD-ROM Boot to Enabled. 

9. In the Advanced menu, select I/O Device Configuration. 

10. Verify the LPT1: is set to ECP. 

11. Exit Setup and Save Changes. 

As the terminal reboots, you should see a message during boot 
indicating that the CD-ROM has been recognized: 

Micro Solutions BACKPACK CD-ROM v0.3 
. . . 
Booting from BACKPACK CD 
Starting MS-DOS 

12. Follow the screen prompts on the client to update the BIOS. You 
can select two methods to run the update program. 

• Automatic BIOS Update – update process runs unattended 

Note: You can see a prompt for terminal model and serial 
number information. If the program detects invalid information 
in the current BIOS, or if you are replacing the processor board, 
there is not model/serial number information in the BIOS. 
Model/Serial Number is mandatory for FitClient operation. 

• Interactive BIOS Update – permits you to input/replace the 
model/serial number information that is stored in the BIOS. 

13. You should see a green window, indicating a successful update. 

14. Press any key to reboot. 

15. When the system reboots, press F2 at the screen prompt to enter 
Setup.  

16. In the Exit menu, select Load Setup Defaults. 

17. Go to the Advanced menu and set Reset Configuration Data to 
[Yes] 

18. Exit Setup and Save Changes. 
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Note: Model/Serial number data that is currently stored in the BIOS 
is displayed during power up. 
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BIOS Crisis Recovery 
The procedures below provide a way to restore the BIOS resulting 
from a non-recoverable condition. 

Note: Use this BIOS crisis recovery procedure only for a 
NON-RECOVERABLE BIOS failure. A non-recoverable BIOS state 
typically results from power loss during a flash BIOS update process. 
This is a rare occurrence and should not be confused with other 
hardware errors that cause a no video state. This procedure is not 
intended to be used for changing or upgrading an operational BIOS. 

Required Hardware 

Part Number Part Name Use 

 PC with at serial port Download BIOS 

497-0408349 Cable, 9-Pin Female to 9-Pin 
Female RS-232 

PC to terminal 
connection 

497-0413418 Parallel Dongle Forces BIOS recovery 

Required Software 
Acquire the following software from NCR. 

NCR 74xx BIOS and BIOS Update Software 
LPIN: A370-0022-0100,  (Version 2.0.0.0 or later) 
P/N: 497-0424310 
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Recovery Procedures 
1. Connect the Parallel Dongle to the parallel connector on the 

terminal. 

19507
Parallel PortCom1

 
2. Connect the two machines with the RS-232 cable. Use COM Port 1 

on both machines. 

19508

NCR 7460

PC

RS-232 Cable

 
3. Boot the PC in the DOS mode with CD-ROM support enabled. 

Note: The PC must be running in the DOS mode (not in a 
Windows DOS box) for the software to operate correctly. 

4. Insert the BIOS update CD into the PC. 

NCR BIOS and BIOS Update Software 
LPIN: A370-0022-0100 

5. Apply power to the terminal. 
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6. On the PC, change directory to the CD-ROM drive. 
E: [Enter] 

7. Enter the update command: 
EMBflash [Enter] 

8. Select the number for the 7460 terminal from the menu list: 
1) 7454 
2) 7401 
3) 7452 
4) 7453 
5) 7455 
6) 7460 
7) 7451 
8) 7456 
 
6 [Enter] 

A blue screen displays as the program runs, showing the program 
progress, followed by a green screen, indicating a successful load. 

PhoenixPhlash Status

PRESS ANY KEY TO EXIT

Flash memory has been successfully programmed

19502  
The Class/Model/Serial # information is deleted using the Crisis 
Recovery procedure. Use the normal BIOS update procedures, as 
discussed earlier in this chapter, to restore the information. 
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Cable/Connector Pin-Out Information 
Parallel Dongle 

19513

25-Pin D-shell Receptacle
(Viewed from wiring side)

25 24 23 22 21 20 19 18 17 16 15 14

13 12 11 10 9 8 7 5 4 3 2 16

 

RS-232 Cable 

19512

1
2

3
4

5
6
7

8

1
2

3
4

5
6
7

8

P1 P2

9-Pin
D-shell

Receptacle
1
6

5
9

P1 P2

1
65

9

9-Pin
D-shell

Receptacle

 
 



 

Chapter 6:  Integrated 2x20 Customer Display 

Introduction 
This chapter defines the character set and the supported commands. 
The NCR 7460 2x20 Customer Display is an integrated line display 
attached to the LPT2 parallel port of the terminal motherboard. 

Viewing Area 
The characters are arranged in 2 rows of 20 characters. Each character 
is a 5x7 dot matrix. 

16674a

1 2 3 20

 

Diagnostics 
Power-Up Diagnostics occur soon after the hardware reset circuitry is 
released, or when a Reset Display command is received from the host 
software. When the hardware is powered down, all registers and 
memory are lost. The display is not capable of any kind of power 
recovery back to a previous state. As a part of the Power-Up 
Diagnostics, the working registers and variables are initialized (set to 
zero). 



6-2 Chapter 6:  Integrated 2x20 Customer Display 

 

Command Descriptions 

Structure/Logic Description 
The 7460 integrated line display consists of a character generator 
controller and display drivers. The CG Controller maps the character 
value to a bitmap stored in memory. The controller outputs the bitmap 
to the appropriate segment drivers for display. The display is 2 lines by 
20 characters where each character is displayed lighting a 5 by 7 
segment.  

The display is controlled by a 7460 terminal motherboard through a 
parallel interface. 

Integrated Display Interface 
The 7460 integrated line display connects internally to the terminal 
motherboard. The display hardware interface is similar to a standard 
parallel port interface. The display is logically connected to LPT2. 
Standard parallel port drivers cannot be used since the standard 
hardware connection is controlled in a non-standard way when 
interfacing to the display. The display is controlled by writing either 
Command or Data bytes through the parallel port to the display. To 
display a character the character value is written as Data to the display. 
The Character Generator controller writes the character bitmap to the 
segment drivers of the display. The cursor position is updated by 
either incrementing or decrementing to the next display data RAM 
position. 

Display Data RAM address 0 is the first character of the first line. The 
last character address of the first line is 19. CGRAM address 64 is the 
first character of the second line. 

The following Table describes the 7460 Integrated Display commands 
supported 
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Instruction Guide 

 

Instructions 

 RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

 

Description 

Execution
Time 

(fosc=270K
HZ 

Clear Display 0 0 0 0 0 0 0 0 0 1 Write “20H” to DDRAM. 
And set DDRAM address to 
“00H” from AC. 

1.52ms 

Return Home 

 

0 0 0 0 0 0 0 0 1 X Set DDRAM address to 
“00H” from AC and return 
cursor to it’s original 
position if shifted. The 
contents of DDRAM are not 
changed. 

1.52ms 

Entry Mode 
Set 

0 0 0 0 0 0 0 1 I/D SH Assign cursor moving 
direction and make shift of 
entry display enable 

37µs 

Display 
ON/OFF 
Control 

0 0 0 0 0 0 1 D C B Set Display (D), cursor (C), 
and blinking of cursor (B) 
on/off control bit. 

37µs 

Cursor or 
Display Shift 

 

0 0 0 0 0 1 S/C R/L X X Set interface data length 
(DL:4-bit/8-bit), numbers of 
display line (N:1-line/2-
line), display font type 
(F:5*8 dots/5*11dots) 

37µs 

Set GGRAM 
Address 

0 0 0 1 AC5 AC4 AC3 AC2 AC1 AC0 Set GGRAM address in 
address counter. 

37µs 

Set DDRAM 
Address 

0 0 1 AC6 AC5 AC4 AC3 AC2 AC1 AC0 Set DDRAM address in 
address counter. 

37µs 

Read Busy 
Flag and 
Address 

0 1 BF AC6 AC5 AC4 AC3 AC2 AC1 AC0 Whether during internal 
operation or not can be 
known by reading BF. The 
contents of address counter 
can also be read. 

0µs 

Write Data to 
RAM 

1 0 D7 D6 D5 D4 D3 D2 D1 D0 Write Data into 
international RAM 
(DDRAM/CGRAM) 

43µs 

Read Data to 
RAM 

1 1 D7 D6 D5 D4 D3 D2 D1 D0 Read Data into international 
RAM (DDRAM/CGRAM) 

43µs 



6-4 Chapter 6:  Integrated 2x20 Customer Display 

 

Instructions 
Instruction RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

Clear Display 0 0 0 0 0 0 0 0 0 1 

Cursor Home 0 0 0 0 0 0 0 0 1 x 

Entry Mode Set 0 0 0 0 0 0 0 1 I/D S 

Display On/Off Control 0 0 0 0 0 0 1 D C B 

Cursor Display Shift 0 0 0 0 0 1 S/C R/L x x 

Function Set 0 0 0 0 1 DL N x BR1 BR0 

CGRAM Address Set 0 0 0 1 CGRAM Address 

DDRAM Address Set 0 0 1 DDRAM Address 

Address Counter Read 0 1 BF=0 AC Contents 

DDRAM or CGRAM Write 1 0 Write Data 

DDRAM or CGRAM Read 1 1 Read Data 

Clear Display 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 0 0 0 0 0 0 1 

This instruction clears the display (without affecting the contents of 
CGRAM) by performing the following: 
1. Fills all DDRAM locations with character code 20H (character code 

for a space). 

2. Sets the AC to DDRAM address 00H (i.e. sets cursor position to 
00H). 

3. Returns the display to the non-shifted position. 

4. Sets the I/D bit to 1. 
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Cursor Home 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 0 0 0 0 0 1 x 

x = don’t care 

This instruction returns the cursor to the home position (without 
affecting the contents of DDRAM or CGRAM) by performing the 
following: 
1. Sets the AC to DDRAM address 00H (i.e. sets cursor position to 

00H). 

2. Returns the display to the non-shifted position. 

Entry Mode Set 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 0 0 0 0 1 I/D S 

This instruction selects whether the AC (cursor position) increments or 
decrements after each DDRAM or CGRAM access and determines the 
direction the information on the display shifts after each DDRAM 
write. The instruction also enables or disables display shifts after each 
DDRAM write (information on the display does not shift after a 
DDRAM read or CGRAM access). DDRAM, CGRAM, and AC 
contents are not affected by this instruction. 
I/D = 0:  The AC decrements after each DDRAM or CGRAM access. If 

S = 1, the information on the display shifts to the right by one 
character position after each DDRAM write. 

I/D = 1:  The AC increments after each DDRAM or CGRAM access. If 
S = 1, the information on the display shifts to the left by one 
character position after each DDRAM write. 

S = 0:  The display shift function is disabled. 

S = 1:  The display shift function is enabled. 
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Display On/Off Control 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 0 0 0 1 D C B 

This instruction selects whether the display and cursor are on or off 
and selects whether or not the character at the current cursor position 
blinks. DDRAM, CGRAM, and AC contents are not affected by this 
instruction. 

D = 0: The display is off (display blank). 
D = 1: The display is on (contents of DDRAM displayed). 
C = 0: The cursor is off. 
C = 1: The cursor is on (8th row of pixels). 
B = 0: The blinking character function is disabled. 
B = 1: The blinking character function is enabled (a character with all 
pixels on will alternate with the character displayed at the current 
cursor position at about a 1Hz rate with a 50% duty cycle). 

Cursor/Display Shift 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 0 0 1 S/C R/L x x 
x = don’t care 

This instruction increments or decrements the AC (cursor position) and 
shifts the information on the display one character position to the left or 
right without accessing DDRAM or CGRAM. DDRAM and CGRAM 
contents are not affected by this instruction. If the AC was addressing 
CGRAM prior to this instruction, the AC will be addressing DDRAM 
after this instruction. However, if the AC was addressing DDRAM 
prior to this instruction, the AC will still be addressing DDRAM after 
this instruction. 

S/C R/L AC contents (cursor position) Information on the display 

0 0 Decrements by one No change 
0 1 Increments by one No change 
1 0 Decrements by one Shifts one character position to the left 
1 1 Increments by one Shifts one character position to the right 
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Function Set 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 0 1 DL N x BR1 BR0 

x = don’t care 

This instruction sets the width of the data bus for the parallel interface 
modes, the number of display lines, and the luminance level 
(brightness) of the VFD. It must be the first command sent after any 
reset. DDRAM, CGRAM, and AC contents are not affected by this 
instruction. 
DL =0: Sets the data bus width for the parallel interface modes 

to 4-bit (DB7-DB4). 

DL = 1:  Sets the data bus width for the parallel interface modes 
to 8-bit (DB7-DB0). 

N = 0:  Sets the number of display lines to 1 (this setting is not 
recommended for multiple line displays). 

N = 1:  Sets the number of display lines to 2 (this setting is not 
recommended for single line displays). 

BR1,BR0 = 0,0: Sets the luminance level to 100%. 

0,1: Sets the luminance level to 75%. 

1,0: Sets the luminance level to 50%. 

1,1: Sets the luminance level to 25%. 

CGRAM Address Set 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 0 1 CGRAM address     

This instruction places the 6-bit CGRAM address specified by DB5-DB0 
into the AC (cursor position). Subsequent data writes (reads) will be to 
(from) CGRAM. DDRAM and CGRAM contents are not affected by 
this instruction. 
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DDRAM Address Set 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 0 1 DDRAM address      

This instruction places the 7-bit DDRAM address specified by DB6-
DB0 into the AC (cursor position). Subsequent data writes (reads) will 
be to (from) DDRAM. DDRAM and CGRAM contents are not affected 
by this instruction. 

Address Counter Read 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

0 1 BF=0 AC contents      

This instruction reads the current 7-bit address from the AC on DB6-
DB0 and the busy flag (BF) bit (always 0) on DB7. DDRAM, CGRAM, 
and AC contents are not affected by this instruction. 
Because the BF is always 0, the host never has to read the BF bit to 
determine if the modules are busy before sending data or instructions. 
Therefore, data and instructions can be sent to the modules 
continuously according to the E, WR/, and SCK cycle times specified 
in section 3.7 AC Timing Specifications. Due to this feature, the 
execution times for each instruction are not specified. 

DDRAM or CGRAM Write 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

1 0 Write data       

This instruction writes the 8-bit data byte on DB7-DB0 into the 
DDRAM or CGRAM location addressed by the AC. The most recent 
DDRAM or CGRAM Address Set instruction determines whether the 
write is to DDRAM or CGRAM. This instruction also increments or 
decrements the AC and shifts the display according to the I/D and S 
bits set by the Entry Mode Set instruction. 
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DDRAM or CGRAM Read 
RS R/W DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0 

1 1 Read data       

This instruction reads the 8-bit data byte from the DDRAM or CGRAM 
location addressed by the AC on DB7-DB0. The most recent DDRAM 
or CGRAM Address Set instruction determines whether the read is 
from DDRAM or CGRAM. This instruction also increments or 
decrements the AC and shifts the display according to the I/D and S bits 
set by the Entry Mode Set instruction. Before sending this instruction, a 
DDRAM or CGRAM Address Set instruction should be executed to set 
the AC to the desired DDRAM or CGRAM address to be read. 

Reset Conditions 
After either a power-up reset or an external reset, the modules 
initialize to the following conditions: 
1. All DDRAM locations are set to 20H (character code for a space). 

2. The AC is set to DDRAM address 00H (i.e. sets cursor position to 
00H). 

3. The relationship between DDRAM addresses and character 
positions on the VFD is set to the non-shifted position. 

4. Entry Mode Set instruction bits: 

I/D = 1: The AC increments after each DDRAM or CGRAM 
access. 

S = 0: The display shift function is disabled. 
5. Display On/Off Control instruction bits: 

D = 0: The display is off (display blank). 
C = 0: The cursor is off. 
B = 0: The blinking character function is disabled. 
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6. Function Set instruction bits: 

DL = 1: Sets the data bus width for the parallel interface modes 
to 8-bit (DB7-DB0). 

N = 1(0): Number of display lines set to 2 for multiple line 
displays (number of display lines set to 1 for single line 
displays). 

BR1,BR0 = 0,0: Sets the luminance level to 100%. 

Note: The function set command must be the first instruction sent 
to the module after any reset. 

Initialization 
The modules can be initialized by using instructions if the modules are 
not reset according to the reset timing detailed in Section 3.7.1 (Reset 
Timing). After any reset, the function set command must be the first 
instruction sent to the module. 
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Character Map (VFD) 

20299

0000 0010 0011 0100 0101 0110 0111 1000 1001 1010 1011 1100 1101 1110 1111

0000

0001

0010

0011

0100

0101

0110

0111

1000

1001

1010

1011

1100

1101

1110

1111 (8)

(7)

(6)

(5)

(4)

(3)

(2)

(1)

(8)

(7)

(6)

(5)

(4)

(3)

(2)

CG
RAM
(1)

Lower
4 Bits

Upper
4 Bits 0001
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Character Map (LCD) 

20068

0000 0010 0011 0100 0101 0110 0111 1000 1001 1010 1011 1100 1101 1110 1111

0000

0001

0010

0011

0100

0101

0110

0111

1000

1001

1010

1011

1100

1101

1110

1111 (8)

(7)

(6)

(5)

(4)

(3)

(2)

(1)

(8)

(7)

(6)

(5)

(4)

(3)

(2)

CG
RAM
(1)

Lower
4 Bits

Upper
4 Bits
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Restriction:  The last two rows of characters stored in the PC2002-L 
and PC2002-M ROM require 5 x 10 dots. The PC2002-L and PC2002-M 
only have 5 x 8 dots so the last two rows of characters beginning at 
11100000 cannot be displayed correctly. These last two rows consist of 
symbols that are not typically used. If one of these characters is 
required, then the recommended method is to use CGRAM (Character 
Generator RAM) to generate them. CGRAM can also be used to 
generate up to 8 custom 5 x 8 characters.  

The CGRAM stores the pixel information (1 = pixel on, 0 = pixel off) for 
the eight user-definable 5x8 characters. Valid CGRAM addresses are 
00H to 3FH. CGRAM not being used to define characters can be used 
as general purpose RAM (lower 5 bits only). Character codes 00H to 
07H (or 08H to 0FH) are assigned to the user-definable characters (see 
Character Map). The graphic below shows the relationship between the 
character codes, CGRAM addresses, and CGRAM data for each user-
definable character. 

20300  
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Appendix A:  Cables 

Corporate ID Part Number Where Used Description 

1416-C359-0007 497-0408349 7167, 7197 RS-232, 9-pin female to 9-pin female 

1416-C266-0040 497-0407943 7167, 7197 RS-232, 9-pin female to 9-pin female 

1416-C266-0152 497-0409379 7167, 7197 RS-232, 9-pin female to 9-pin female 

1416-C528-0010 497-0415949 7167, 7197 USB, 1 meter 

1416-C528-0040 497-0415950 7167, 7197 USB, 4 meter 

1416-C337-0010 497-0407427 7196 RS-232, integrated 

1416-C337-0040 497-0407429 7196 RS-232, remote 

1416-C337-0152 497-0407430 7196 RS-232, interface 50' 

1416-C372-0006 497-0409394 Cash Drawer Dual Cash Drawer (Y cable) 

1416-C112-0006 497-0409394 Cash Drawer Cash Drawer (Ext. cable) 

1416-C542-0002 497-0414489 Keyboard PS/2, Y-Cable 

1416-C338-0005 497-0407490 Keyboard Wedge, Y-Cable 

1416-C278-0040 497-0405676 5972 Parallel, Remote Customer Display 

1416-C279-0010 497-0405678 5972 RS-232, Remote Customer Display 

1416-C279-0040 497-0405679 5972 RS-232, Remote Customer Display 

1416-C473-0040 497-0413365 5973/5974 Parallel, Remote Customer Display 

1416-C792-0004 497-0425405 DVI to DVI Operator Display 

1416-C634-0040 497-0418406 5945, 5992 RS-232, 9-pin female to 5945/5992 

1416-C059-0030 497-0008905 LAN Ethernet, 10/100BaseT 

1416-C321-0030 006-8601012 7460 Power Cord – UK 



A-2 Appendix A:  Cables 

 

Corporate ID Part Number Where Used Description 

1416-C323-0030 006-8601010 7460 Power Cord – International 

1416-C393-0030 006-8601001 7460 Power Cord – Japan 

1416-C408-0030 006-8601011 7460 Power Cord – SEV 

1416-C410-0030 006-8601019 7460 Power Cord – Australia 

1416-C419-0030 006-8601020 7460 Power Cord – U.S. Twist-lock 
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Printers 

7167, 7197 Printer (RS-232) 

19722a

9-pin
D-shell

Receptacle

9-pin
D-shell

Receptacle

497-0408349 - 0.7 m
(1416-C359-0007)

497-0407943 - 4 m
(1416-C266-0040)

497-0409379 - 15 m
(1416-C266-0152)

RS-232
(Printer)

RS-232
(Terminal)

 

7167, 7197 Printer (USB) 

18433a

Type A
USB

497-0415949  (1 meter)
1416-C528-0010

498-0415950  (4 meter)
1416-C528-0040

P1

Type B
USB

P2

1
2

3
4

1
2 3

4
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7196 Printer (RS-232) 

20127b

9-pin
D-shell

Receptacle

25-pin
D-shell

Plug

497-0407427 - 1.0 m
(1416-C337-0010)

497-0407429 - 4 m
(1416-C337-0040)

497-0407430 - 15.2 m
(1416-C337-0152)

RS-232
(Printer)

RS-232
(Terminal)

 

Cash Drawers 

Cash Drawer, Extension Cable 

19730a

230-0145735 - 3.0 m
(1424-C112-0030)

Cash Drawer
(Terminal/Printer)

Cash Drawer
(Cable)

Modular
6-Pin  Jack

Modular 
6-Pin Plug

 



  Appendix A:  Cables A-5 

 

Keyboard PS/2 Y-Cable 

17894a

PS/2
(Mouse) 

PS/2
(Terminal)

6-pin
Mini-DIN

Plug

6-pin
Mini-DIN

Receptacle

PS/2
(Keyboard)

5-pin
Mini-DIN

Receptacle

51 mm
(2 in.)

497-0414489 - 0.2 m
1416-C542-0002)

 

5964 to 7460 (RS-232/PS2/Power) 

497-0425664
(1416-C800-0004)

20310a

RS-232
(Terminal)

PS/2
(Terminal)

12 V COM
(Display)
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Remote Customer Display 

5972 VFD (Parallel) 

20277

Power

8-pin
Microfit
Receptacle

Customer
Display

Terminal
Parallel Port

497-0405676 - 4m
1416-C278-0040

25-pin
D-Shell

Receptacle

24-pin
Microfit

Receptacle

 

5972 VFD (RS-232) 

20278

Customer
Display

Terminal
RS-232

Port

9-pin
D-shell

Receptacle

24-pin
Microfit

Receptacle

Power
8-pin

Microfit
Receptacle

497-0405678 - 1.0 m
(1416-C279-0010)

497-0405679 - 4.0 m
(1416-C279-0040)
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5973/5974 International VFD (Parallel) 

20280

Power

8-pin
Microfit
Receptacle

Customer
Display

Terminal
Parallel Port

497-0413365 - 4m
1416-C473-0040

25-pin
D-Shell

Receptacle

30-Position
Microfit

Receptacle

 
 

Operator Display Cable (DVI to DVI) 

20303

497-0422831 - 400 mm
(1416-C792-0004)24-Pin

DVI-D Plug
24-Pin

DVI-D Plug

DVI
(Terminal)

DVI
(Operator
Display)
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5945/5992 Cable (RS-232) 

20149

Sub Miniature D-Shell
9-Pin

Receptacle

RS-232
(5945/5992)

RS-232
(Terminal)

497-0418406 - 4 m
1416-C634-0040

 

Ethernet 10/100BaseT Cable 

16298a

Modular
8-Pin
Plug

Modular
8-Pin
Plug

497-0008905 - 3.0 m
(1416-C059-0030)

 

Power Cables 

 AC Power 

15405a

Terminal

006-1009037 - U.S.

The following power cables (not shown)
also have an IEC connection of 45 mm:
  006-8601001 - Japan Twist-Lock
  006-8601010 - International
  006-8601011 - SEV
  006-8601012 - U.K.
  006-8601019 - Australia

 



 

Appendix A:  Kits 

This section contains a comprehensive list of the available hardware 
Feature Kits that can be installed in the customer environment. Kit 
installation instructions (for those requiring instruction) are available 
on the Information Products web sites. 

• Internet: http://www.info.ncr.com 

• NCR Intranet: http://inforetail.atlantaga.ncr.com 

To locate the installation guides on these sites: 

1. Select General Search. 

2. Select the Kits icon. 

3. In the Title field, enter the Kit Title. 

Example: Memory 

or 

In the Product ID field, enter the Kit Number. 

Example: 7460-K800 

1. Select Search. 

The file can be viewed online by left-mouse clicking on the pub title, or 
if you prefer to download the entire file you can right-mouse click on 
the title and then a Save target as. 

If you aren’t sure of the title or number you can display all kits 
associated with a terminal product class by: 

1. In the Class drop-down list, enter the Class of the terminal. 

Example: 7460 

2. Select Search. 
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Kit Number Description 

7460-K022 128MB memory 

7460-K023  256MB memory 

7460-K102  Display Mount 

7460-K104  Front Mount MSR 

7460-K451 Integrated Customer Display (LCD) 

7460-K452 Integrated Customer Display (VFD) 

7460-K800 1.44 Mbps External Flex Disk Drive 

7460-K900 256MB Compact Flash Memory 

 



 

Appendix C:  Technical Specifications 

Interrupt Defaults 
IRQ System Resource 

0 System Timer 

1 Keyboard 

2 Cascade 

3 Serial Port (COM 2) 

4 Serial Port (COM 1) 

5 LPT 2 

6 Floppy (if present) 

7 LPT 1 

8 Real Time Clock 

9 Video/Audio/LAN (shared); USB if IRQ 12 is used 

10 Serial Port (COM 3) for Serial Touch 

11 Serial Port (COM 4) 

12 USB; PS/2 Touch/Mouse if present 

13 Math coprocessor 

14 IDE Hard Disk 

15 MSR 
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DMA Channel Defaults 
DMA Data Width System Resource 

0 8- or 16-bits Open 

1 8- or 16-bits Open 

2 8- or 16-bits Floppy 

3 8- or 16-bits Parallel Port (for ECP/EPP Config.) 

4  Reserved - Cascade channel 

5 16-bits LAN 

6 16-bits Open 

7 16-bits Open 
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Memory Map 
Address Range  Size Description 

FFFFFFFF-FFF80000 512KB BIOS ROM 

FFF80000-FFF81FFF 8KB BIOS ESCD 

100000-FFFFFFF 255MB Extended Memory (1MB to 255MB) 

E8000-FFFFF 96KB BIOS run-time 

E4000-E7FFF 16KB BIOS DMI 

E0000-E3FFF 16KB LAN PXE ROM (if MSR and/or DOC enabled) 

DC000-DFFFF 16KB MSR and/or DOC if either is enabled (DOC at DC000 or 
MSR at DE000) 

D8000-DBFFF 16KB MSR and/or DOC if either is enabled (DOC at D8000 or 
MSR at DA000) 

D4000-E0000 48KB LAN PXE ROM (uses D8000-DFFFF only if no MSR/DOC) 

D2000-D3FFF 8KB Available HI DOS memory 

D0000-D1FFF 8KB Micro-Solutions Backpack CD ROM (if enabled) 

CC000-CFFFF 16KB Available HI DOS memory 

C0000-CBFFF 48KB Video BIOS 

A0000-BFFFF 128KB Video frame buffering 

9FC00-9FFFF 1KB Extended BIOS data 

80000-9FBFF 127KB Extended memory 

00000-7FFFF 512KB Conventional memory 

DA000-DBFFF or 
DE000-DFFFF 

8KB NCR Trigantor MSR (optional) 

D8000-D9FFF or 
DC000-DDFFF  

8KB Flash Disk (optional) 

Note: If you are using the side mounted MSR, the MSR address range can be disabled. 
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I/O Map 
Address 
(hex) 

Size Description (Default/Primary Resource) Description (Alternate Configurable Resource) 

0 16 DMA Controller  
20 8 Interrupt Controller  
40 4 System Timer  
60 8 Keyboard Controller  
70 8 Real Time Clock  
80 16 DMA Page Controller  
90 8 System Control Port  
98 8 Reserved  
A0 8 Slave Interrupt Controller  
A8 24 Reserved  
C0 32 Slave DMA Controller  
F0 16 Math Co-Processor  
1F0 8 IDE Controller, Channel 1  
220 8  COM C or COM D 
228 8  COM C or COM D 
278 8 LPT2 LPT1 
2E8 8 COM D COM A or COM B or COM C 
2F8 8 COM B COM A or COM B or LPT2 
378 8 LPT1 LPT2 
3BC 8  LPT1 
3C0 8 Video  
3E8 8 COM C (Serial Touch) COM A or COM B or COM B 
3F0 8 Floppy Drive  
3F8 8 COM A  
1800 8 IDE  
1810 8 SM Bus  
1820 8 USB  
1840 8 Audio  
1C00 8 Audio  
2000 4096 PCI-to-PCI Bridge  
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—B— 
BIOS crisis recovery, 5-5 
BIOS Crisis Recovery, 5-5 
BIOS Default CMOS Values, 3-2 
BIOS Recovery 

crisis recovery procedures, 5-5 
using CD-ROM, 5-1 

BIOS Setup 
Entering Setup without a keyboard, 3-1 

—C— 
Cable Connectors, 2-4 
Cables, A-1 
Calibrating the Touch Screen, 2-14 
Cash drawer 

Installation, 2-11 
Cash Drawers, 1-21 

third-party requirements, 1-21 
Character Map (LCD), 6-12 
Character Map (VFD), 6-11 
Colors supported, 1-12 
Configuration diagram, 1-6 
Crisis Recovery 

BIOS, 5-5 
Customer Display 

installation, 2-9 
Customer Display (2x20), 6-1 

command descriptions, 6-2 
diagnostics, 6-1 

Customer Displays, 1-19 

—D— 
Display Interface 

integrated 2.x 20, 6-2 
DMA Channel Defaults, B-2 
Double-Touch Condition, 2-19 

—E— 
Ethernet, 1-8 

—F— 
FLASH Memory, 1-13 

—G— 
Gold Disk Contents, 4-7 

—H— 
Hard disk drive, 1-22 
Hardware monitor, 1-10 
Hardware options, 1-4 

Features not supported, 1-5 

—I— 
I/O Map, B-4 
Instructions 

integrated 2 x 20, 6-4 
Integrated customer display 
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Description, 1-15 
Interrupt Defaults, B-1 
IRQ 

defaults, B-1 

—K— 
Keyboard 

installation, 2-12 
Keyboard Installation, 2-12 
Kits, A-1 

—L— 
LAN status LEDs, 1-23 
LCD backlight inverter module, 1-14 

—M— 
Magnetic stripe reader, 1-11 
Memory Map, B-3 
MicroTouch Touchscreen, 2-15, 2-19 
Model number, 1-2 
Mouse 

installation, 2-12 
Mouse Installation, 2-12 
MSR, 1-11, 1-16 

Side Mount, Front Mount. See 
MSR Cleaning Cards, 2-20 

—N— 
Noise Check Utilty, 2-18 

—O— 
Operating System Recovery 

using CD-ROM, 4-1 
Operator display 

Description, 1-14 
OS Recovery 

from a larger image, 4-14 

—P— 
Parallel Port, 1-10 
Part Numbers 

MSR Cleaning Cards, 2-20 
Plug and Play, 1-13 
Power Management, 1-23 
Power Status LED, 1-22 
Power supply 

Description, 1-23 
Powering Down the Terminal, 2-20 
Printer 

installation, 2-6 
Printer Installation, 2-6 
Printers, 1-17 
Processor board 

Description, 1-7 
Features, 1-3 

Processor/chip set, 1-7 
PS/2, 1-10 

—R— 
Remote customer display 

Installation, 2-9 
Removing power, 2-20 
Resolutions supported, 1-12 
RS-232 Printer Installation, 2-8 

—S— 
Serial Mouse 

installation, 2-13 
Serial number, 1-2 
Serial ports, 1-9 
Serial Ports, 1-9 
Setup 

Default factory settings, 3-2 
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Eentering with a keyboard, 3-1 

—T— 
Technical Specifications, B-1 
Terminal Power Cables, A-8 
Touch Screed 

calibrating, 2-14 

—U— 
USB, 1-9 
USB Printer Installation, 2-7 

—V— 
Video subsystem, 1-7 

—W— 
Wake on Touch Restriction, 1-26 
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